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Project Development

• Create a project
– All development in 

VisualDSP++ occurs 
within a project.

– The project file (.DPJ) 
stores your program’s 
build information: 
source files list and 
development tools 
option settings

– A project group file 
(.DPG) contains a list 
of projects that make 
up an application (eg
ADSP-BF561 dual core 
application)
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Select Target ProcessorSelect Target Processor
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Startup CodeStartup Code
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FinishFinish
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C/C++ Project C/C++ Project -- Startup CodeStartup Code

For pure assembly code applications, select ‘NO’ option.  For C/C++ applications, 
select ‘YES’ to customize a run time header for you application.
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Setup of Configurable Memory Blocks in L1Setup of Configurable Memory Blocks in L1
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Wizard is DoneWizard is Done

When finished, the wizard creates a customized C Run Time Header.

At a later time, the 
CRT Header can 
be modified by 
selecting Project 
Options/Startup 
Code Settings and 
making changes.
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Project Development Steps

• Create project source files
– A project normally contains one 

or more C, C++, or assembly 
language source files. 

– After you create a project and 
define its target processor, you 
add new or existing files to the 
project by importing or writing 
them. 

– The VisualDSP++ Editor lets 
you create new files or edit any 
existing text file
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Project Development Steps

• Define project build 
options

– A project’s configuration setting 
controls its build. By default, the 
choices are Debug or Release.

– Debug 
• Typically has more debug 

options set for the tools. 
• compiler generates debug 

information to allow source 
level debug. 

– Release 
• Typically has fewer or no 

debug options set for the 
tools  

• builds are usually 
optimised for performance
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VisualDSP++ Menu

Add source, 
header and .ldf 

files to your 
project.

Build the project

File specific options:
Select file, press right 

mouse button, choose: 
File Options

Reload the project
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.S

C - CompilerC - Compiler

Software Build Process Software Build Process 
Step 1 Step 1 -- Compiling  & AssemblingCompiling  & Assembling

Object Files
(.DOJ)

cFile1.C

asmFile1.ASM Assembler

Source Files 
(.C and .ASM)

cFile1.DOJ

asmFile1.DOJ
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Software Build ProcessSoftware Build Process
StepStep--1 Example:  Assembly Source1 Example:  Assembly Source

asmFile1.ASM

.section data1;

.var array[10]

.section code1;

start:r0 = 0x1234;

r1 = 0x5678;

r2 = r1 + r2;

jump start;

Object Section = code1

start:
r0 = 0x1234;
r1 = 0x5678;
r2 = r1 + r2;
jump start;

Object Section = data1

array[0]
array[1]

...

...
array[9]

asmFile1.DOJ

AssemblerAssembler
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.S

Software Build Process Software Build Process 
StepStep--1 Example:   C Source1 Example:   C Source

main()
{

int  j = 12;
int  k = 0;
k += j * 2;
func1();

}

void func1(void)
{

int var1;
foo = 1;
foo ++;

}

Object Section = program

_main:
. . .

r2 = r3 * r4;
r0 = r0 + r2;
dm( _k ) = r0;
ccall  _func1;
_func1:
r1 = dm( m3, i6 )
r1 = r1 + 1;
. . .

Object Section = stack

_j       : 12
_k      : 0
_var1: 1

cFile1.C cFile1.DOJ

C-CompilerC-Compiler

AssemblerAssembler
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Software Build Process Software Build Process 
Step 1 Example:   C Source with Alternate SectionsStep 1 Example:   C Source with Alternate Sections

section (“extern”) int array[256];

section (“foo”) void bar(void)
{

int foovar;
foovar = 1;
foovar ++;

}

foo.C foo.DOJ

Object Section = foo

_bar :
r0 = dm(_foovar);
r0 = r0 + 1;C-CompilerC-Compiler

Object Section = extern

_array [00]
_array [01]
…

_array [255]

AssemblerAssembler

Object Section = stack

_foovar: 1
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DirectivesDirectives
• Preprocessor Directives

− #define - define a macro or constant
− #undef - undo macro definition
− #if, #endif - conditional assembly
− #else, #elif - multiple conditional blocks
− #ifdef, #ifndef - condition based on macro definition
− #include - include source code from another file
− #error - report an error message

• Assembler directives
− .ALIGN - specify alignment for code/data
− .BYTE | .BYTE2 | .BYTE4

- define and initialize one-, two-, and four-
byte data

− .VAR - define and initialise 32-bit data object
− .EXTERN - allow reference to global variable
− .GLOBAL - change symbols scope to global
− .SECTION - mark beginning of a section
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AssemblerAssembler

• Assembler operators
− ~ - ones complement
− - - unary minus
− * - multiply
− / - divide
− % - modulus
− + - addition
− - - subtraction
− << - shift left
− >> - shift right
− & - bitwise AND (preprocessor only)
− | - bitwise inclusive OR
− ^ - bitwise exclusive OR (preprocessor only)
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AssemblerAssembler

• Assembler operators (cont’d)
− ADDRESS(symbol) - address of symbol
− BITPOS(constant) - bit position
− symbol - address pointer to symbol
− LENGTH(symbol) - length of symbol
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AssemblerAssembler

• Assembler command line switches
− -Dmacro [definition] - define macro
− -g - generate debug information
− -h - output list of assembler switches
− -i directory - search directory for included files
− -l filename - output named listing file
− -li filename - output named listing file with #include files
− -M - generate dependencies for #include and 

data files
− -MM - generate make dependencies for #include 

and data files
− -Mo filename - write make dependencies to file
− -Mt filename - specify the make dependencies target name
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AssemblerAssembler

• Assembler command line switches (cont’d)
− -micaswarn - treat multi-issue conflicts as warning
− -o filename - output the named object file
− -pp - run preprocessor only (do not assemble)
− -proc processor - specify processor
− -sp - assemble without preprocessing
− -v - display information on each assembly phase
− -version - display version information for assembler
− -w - remove all assembler-generated warnings
− -Wnumber - suppress any report of the specified warning
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Assembler

Preprocessor

Object File
.doj (binary)

Listing File
.lst (ASCII)

Assembler

Assembler file
.asm

Data File
.dat

Header file
.h

Intermediate
.is
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#include <defBF533.h>

#include “myheader.h”

#ifdef mydef

R0 += 1;

#else

R0 += -1;

#endif

Assembler Property Page
If you want to 

get the 
intermediate 
.is file, select 

here

Depending on 
definitions, you 

can select 
different codes

If chosen, a 
listing file 

will be 
created

If chosen, you 
are able to 

debug in the 
source code

mydef
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SSectionections in Assembler Filess in Assembler Files

• The .SECTION directive marks the beginning of a logical section 
− data and code form the content of a section
− Multiple sections may be used within a single source file
− Any section name may be chosen

.SECTION data_a;
.BYTE data_array[N];

.SECTION data_b;
.VAR coeff_array[N];
.VAR x = 0x12345689;

.SECTION program;
_main:  P0.H=data_array;

P0.L=data_array;
L0=length(data_array);

. . .
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The defBF533.h Header FilesThe defBF533.h Header Files

• Allows Programmer to Use Symbols for Memory Mapped Registers
• Located in: \\VisualDSP\Blackfin\include\

To include it use:
#include <defBF533.h> or
#include <defLPBlackfin.h>

Example: 
P0.L = LO(TIMER0_CONFIG);
P0.H = HI(TIMER0_CONFIG );
R0 = 0x2345(Z);
W[P0] = R0.L; // Write 0x2345 to TIMER0_CONFIG

• Operators LO(expression) and HI(expression) must be used to load the 
32-bit macros that are #define‘d in defBF533.h into 16-bit registers.

NOTE: expression can be symbolic or constant
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Assembler Source File Example 

#include <defBF533.h>

#define N 20 // replace N by 20

.GLOBAL start;

.SECTION data_a; // data in L1 memory bank A

.VAR buffer[N]="fill.dat";  // initialize data from file

.SECTION data_b; // data in L1 memory bank B

.VAR xy = 0x12345678; // initialize var with 32bit value

.SECTION L2_program; // instructions in L2 memory

start: I0 = buffer (z); // get low address word of array and load index register
I0.H = buffer; // get high address word of array and load index register
B0=I0; // load base register with address

L0=N*4; // size of array (circular buffer!) in bytes

R0=0;
P0=N;

lsetup(loopstart,loopend) LC1 = P0; // setup loop
loopstart: R0 += 1; // 1st instruction in loop
loopend: [I0++]=R0; // last instruction in loop
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Macros

#define mymacro(x,y) R0 = x; R1 = y; R2 = R0 + R1

.SECTION program;

start: mymacro(0x4,P0);

[I0++] = R2;

The Preprocessor will create the following:
start: R0 = 0x4 (Z); 

R1 = P0; 
R2 = R0 + R1;
[I0++] = R2;

Semicolon either here or here
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Software Development FlowSoftware Development Flow
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Linker Description FileLinker Description File
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OBJECT SECTION
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OBJECT SECTION

OBJECT SECTION

OBJECT SECTION
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LDF
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LinkerLinker

• Generates a Complete Executable DSP Program (.dxe)
• Resolves All External References
• Assigns Addresses to re-locatable Code and Data Spaces
• Generates Optional Memory Map
• Output in ELF format

− Used by downstream tools such as Loader, Simulator, and 
Emulator

• Controlled by linker commands contained in a linker description 
file (LDF)
− An LDF is required for each project
− Typically modify a default one to suit target application



34

8-34 a

Linker

Linker

Memory Image File
.DXE (binary)

Library Files
.DLB

Object File
.DOJ

Linker Description
Files .LDF

Memory Map File
.MAP (.xml)
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Linker Property Page

If chosen, a 
.map file 
will be 

created

All symbol 
names will be 
removed, if 

chosen



36

8-36 a

The Linker Description File (LDF)

• The link process is controlled by a linker command 
language

• The LDF provides a complete specification of mapping 
between the linker's input files and its output. 

• It controls
- input files 
- output file 
- target memory configuration 

• Preprocessor Support
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LDF consists of three primary parts

• Global Commands
- Defines architecture or processor
- Directory search paths
- Libraries and object files to include

• Memory Description
- Defines memory segments

• Link Project Commands
- Mapping of input sections to memory segments
- Output file name
- Link against object file list
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ARCHITECTURE (ADSP-BF533)
SEARCH_DIR ($ADI_DSP\Blackfin\lib)
$OBJECTS = $COMMAND_LINE_OBJECTS;

MEMORY
{

seg_data_a { TYPE(RAM) START(0xFF800000) END(0xFF803FFF) WIDTH(8) }
seg_data_b { TYPE(RAM) START(0xFF900000) END(0xFF903FFF) WIDTH(8) }
seg_data_scr { TYPE(RAM) START(0xFFB00000) END(0xFFB00FFF) WIDTH(8) }
seg_prog { TYPE(RAM) START(0xFFA00000) END(0xFFA03FFF) WIDTH(8) }

}

Example LDF
Global Commands & Memory Description

Segment 
name

Start 
address

End 
address

Memory 
width

Global Commands
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PROCESSOR p0
{

OUTPUT( $COMMAND_LINE_OUTPUT_FILE )
SECTIONS

{
sec_data_a
{ INPUT_SECTIONS( $OBJECTS(data_a) ) } > seg_data_a
sec_data_b SHT_NOBITS
{ INPUT_SECTIONS( $OBJECTS(data_b) ) } > seg_data_b
sec_data_scr
{ INPUT_SECTIONS( $OBJECTS(data_scr) ) } > seg_data_scr
sec_prog
{ INPUT_SECTIONS( $OBJECTS(prog) ) } >seg_prog

}
}

Example LDF (con‘t)
Link Commands

MEMORY SEGMENTS
Declared in the LDF

DXE SECTION NAMES
Used in .map file

OBJECT SECTIONS
from assembly files

Keyword:
Data in that
SECTION
will not be 
initialized
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Expert LinkerExpert Linker

Using the  LDF Wizard
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Expert Linker FeaturesExpert Linker Features

Expert Linker is a Graphical tools that can:
• Use wizards to create LDF files
• Define a DSP’s target memory map
• Drag and Drop object sections into the memory map
• Present watermarks for max Heap and Stack usage
• Graphically Manage Overlay support
• Import Legacy LDF files 
• Graphically highlights code elimination of unused objects
• Profile object sections in memory
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Create LDF WizardCreate LDF Wizard
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LDF ResultLDF Result

This is a memory map view of the generated .ldf file.  In this 
mode, each section’s start and end address are shown in a list 
format.
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LDF Result (contLDF Result (cont’’d)d)

This is a graphical view of the memory map.  Double click on the
section to zoom in.
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Control Mapping of SectionsControl Mapping of Sections

Unmapped sections can be 
‘mapped’ simply by dragging to 
an appropriate memory segment.  
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Post Link and Profiling ResultsPost Link and Profiling Results

Post Link results 
indicate how much 

memory was actually 
used

Results of profiling 
indicate which objects 

use more CPU time
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Software Development FlowSoftware Development Flow
Step Three Step Three -- DebuggingDebugging

Source Files
(.C and .ASM)

Debugger
(In-Circuit Emulator, 
Simulator, or EZKIT )

Boot Image
(.LDR)

Boot Code 
(.DXE)

Boot Code 
(.DXE)

Loader / 
Splitter

Compiler &
Assembler

Object Files
(.DOJ)

Executable
(.DXE)

Linker
Description 
File (.LDF)

Linker
Description 
File (.LDF)

Linker



49

8-49 a

DebuggerDebugger
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Debugger FeaturesDebugger Features

• Single step
• Run
• Halt
• Run to breakpoint
• Profiling
• Pipeline Viewer
• Cache Viewer 
• Plotting
• Simulate Standard I/O, Interrupts and Streams
• Compiled simulation for faster simulation times
• Run To Main
• STDIO
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Compiled SimulationCompiled Simulation

• Traditional simulator decodes/interprets one instruction at a 
time
− large processing overhead during simulation

• With Compiled Simulation a Blackfin DXE file is “preprocessed”
and converted into an executable for the system hosting 
VisualDSP++
− processing overhead during simulation is drastically reduced

• Can be executed
− in VisualDSP++ using debug features (breakpoints, single step, 

displaying registers and memory, etc)
− “stand-alone” without VisualDSP++ using streams and file 

input/output
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VisualDSPVisualDSP++ Debug Control++ Debug Control

• Breakpoints
− Symbol
− Address

• Conditional Breakpoints (“watchpoints”) [Simulation Only]
− Register

• Any Read or Write
• Read or Write of an undefined value
• Read or Write of a specific value.

− Memory Ranges
• Any Read or Write
• Read or Write of an undefined value
• Read or Write of a specific value
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VisualDSPVisualDSP++ Debug Control ++ Debug Control 

• Single Step ( Step into )
− Step through the program one instruction at a time

• Step Out Of, Step Over
− Used when debugging C Code

• External Interrupts
− Set number of instruction cycles between interrupts
− Random Interval possible

• Stream I/O
− Used to simulate IO, serial ports and parallel ports
− Assign data-files as source/destination
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VisualDSPVisualDSP++  Debugger Windows++  Debugger Windows

• Disassembly Window
− View disassembled assembly code

• Source Window
− C, Mixed C/Assembly

• Local Window
− Displays all local variables within current function

• Expressions  Window
− Any “C” expression
− Register names preceded by a $   (for example  $R12)

• Profile Window
− Cycle-Count & Percentage of time spent executing in specified 

address ranges
• Plot

− Enhanced plot capability
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Run to Main & STDIORun to Main & STDIO

• Run To Main
− Allows the user to control whether or not the debugger, on a load, 

starts execution in the run time header or at the first line in main().

• STDIO
− Full STDIO support.  Use printf() and scanf() to access files on the 

host system.
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Using the Pipeline ViewerUsing the Pipeline Viewer
• Accessed through View->Debug Windows->Pipeline Viewer

in a simulator session (not available in emulator)
• Enabled through the context menu

• Place the cursor on a stall and press CTRL key to see more info 
about it
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Using the Cache ViewerUsing the Cache Viewer

• Accessed through View->Debug Windows->Cache Viewer in 
a simulator session (not available in emulator)

• Enabled through the context menu

Provides information about 
the efficiency of the cache
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Using the Cache ViewerUsing the Cache Viewer
• Place the cursor on a stall and press CTRL key to see more 

info about it
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Using Linear ProfilingUsing Linear Profiling

• Linear Profiling accessed through Tools->Linear 
Profiling->New Profile in a simulator session 

• Enable the Linear Profiler through the context menu
• Single-step, or run and halt to update the results



60

8-60 a

Using Statistical ProfilingUsing Statistical Profiling
• Statistical Profiling accessed through Tools-

>Statistical Profiling->New Profile in an emulator 
session

• Enable the Statistical Profiler through the context menu
• Run and watch as the results are updated in real-time; 

Halting keeps the last snapshot on the screen
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C/C++ ProfilerC/C++ Profiler
• The profiler is very useful in C/C++ mode because it makes it 

easy to benchmark a system on a function-by-function (i.e. 
C/C++ function) basis
− Assembly modules can be wrapped in C/C++ functions to take 

advantage of this
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Programming Exercise #1Programming Exercise #1

Lab 7
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Reference MaterialReference Material

Code Development
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Read The ReadMe Files!

Upgrades/Documentation/Tool Anomalies available at:
http://www.analog.com
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Listing file (.lst)
Page 1  .\test.asm
ADI easmblkfn (2.1.5.0) 02 Apr 2002 15:32:00

offset       opcode line
======       ======  ====

1 #include <defBF533.h>;
2 #define N   20          //replace N by 20
3 .GLOBAL     start;
4 .SECTION    data_a;         //data in L1 memory bank A
5      .VAR   buffer[N]="fill.dat";   //initialise data from file
5 
6 .SECTION    data_b;     //data in L1 memory bank B
7     .VAR    x = 0x12345678;        //initialise variable
8 .SECTION    L2_program;     //instructions in L2 memory

0                  9 start:  I0 = buffer (z);    //get low address word of array 
0         90e1     9 
2         0000     9 
4         50e1    10         I0.H = buffer;      //get high address word of array 
6         0000    10 
8         8036    11         B0=I0;              //load base register
a         3ce1    12         L0=N*4;     // size of array (circular buffer!) in bytes
c         5000    12 
e         0060    13         R0=0;
10         a068    14         P0=N;
12         b0e0    15         lsetup(loopstart,loopend) LC1 = P0;         // setup loop   
14         0000    15 
16                 16 loopstart:      R0 += 1;    // 1st instruction in loop
16         0864    16 
18                 17 loopend:        [I0++]=R0;  // last instruction in loop
18         009e    17 

Line Nr. in the source code

Offset within the 
specified section

Generated opcode

Source code
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Example Global Commands

ARCHITECTURE (ADSP-BF533)
// Processor Used

SEARCH_DIR( $ADI_DSP\Blackfin\lib )
// Directories to search for files

$OBJECTS = bootup.doj, $COMMAND_LINE_OBJECTS;
// Macro listing all command line objects and bootup
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Linker Description File Macros

• $COMMAND_LINE_OBJECTS:
List of objects (.DOJ) and libraries (.DLB) passed on 
command line.

• $COMMAND_LINE_OUTPUT_FILE:
Output executable file name specified on the command 
line with the -o switch.

• $ADI_DSP:  Path to VisualDSP installation directory.

• $macro:  User defined macro for a list of files.
e.g.: $OBJECTS


